Copyright and Disclaimer

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means electronic, mechanical, photocopying, recording, or otherwise without the prior written permission of CyberLink Corporation.

To the extent allowed by law, AudioDirector IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY WARRANTY FOR INFORMATION, SERVICES, OR PRODUCTS PROVIDED THROUGH OR IN CONNECTION WITH AudioDirector AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, EXPECTATION OF PRIVACY, OR NON-INFRINGEMENT. BY USING THIS SOFTWARE, YOU AGREE THAT CYBERLINK WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, OR CONSEQUENTIAL LOSS ARISING FROM THE USE OF THIS SOFTWARE OR MATERIALS CONTAINED EITHER IN THIS PACKAGE.

The terms and conditions here under shall be governed and construed in accordance with the laws of Taiwan.

AudioDirector is a registered trademark along with other company and product names mentioned in this publication, used for identification purposes and remain the exclusive property of their respective owners.

International Headquarters

Mailing Address
CyberLink Corporation
15F., No. 100, Minquan Rd., Xindian Dist.
New Taipei City 231, Taiwan (R.O.C.)

Web Site
http://www.cyberlink.com

Telephone
886-2-8667-1298

Fax
886-2-8667-1300

Copyright © 2012 CyberLink Corporation. All rights reserved.
# Contents

## Introduction

Welcome

| Main Features | 1 |
| DirectorZone | 2 |
| Updating AudioDirector | 2 |

System Requirements | 3 |

---

## AudioDirector Workspace

AudioDirector Rooms | 6 |

Media Library | 6 |

Adjustments and Effects Panel | 6 |

AudioDirector Timeline | 7 |

| Audio Channels | 8 |
| Range Selection | 10 |
| Timeline View | 10 |
| Timeline Markers | 12 |
| Timeline Zoom | 12 |

AudioDirector Quick Bar | 13 |

Playback Controls | 15 |

| Video File Playback | 16 |
| Audio Level Meter | 17 |

Expanding the Workspace | 18 |

Keyframes Panel | 20 |

| Volume Tab | 20 |
| Effect Tab | 20 |
AudioDirector Preferences ................................................................. 21
  General Preferences .......................................................................... 21
  File Preferences ................................................................................ 21
  Project Preferences .......................................................................... 22
  DirectorZone Preferences ................................................................ 22
  Audio Setting Preferences ............................................................... 23

**Importing Media into the Library** .................................................. 25

Importing Audio and Video Files ........................................................ 25
  Supported Formats ............................................................................ 25
  Downloading Sound Clips ................................................................ 26
  Downloading Sound Clips from DirectorZone ................................... 26
  Downloaded Sound Clips Library ...................................................... 26
  Recording Audio .............................................................................. 27
  Recording Settings ........................................................................... 27

**AudioDirector Projects** ................................................................. 29

**Editing Audio** .............................................................................. 31

Using the Editing Tools ..................................................................... 31
  Adjusting Audio ............................................................................... 32
    Applying Fades ............................................................................. 32
    Trimming Audio .......................................................................... 34
    Adjusting Length ........................................................................ 35
    Adjusting Pitch ........................................................................... 36
    Inserting Silence ....................................................................... 36
    Inserting Noise .......................................................................... 37
    Reversing Audio ........................................................................ 38
    Adjusting the Master Volume ....................................................... 38
    Panning Audio Left/Right ............................................................ 39
  Applying Audio Effects ................................................................... 41
    Using Dynamic Range Control .................................................... 41
    Using the Equalizer .................................................................... 42
Applying the Radio Effect ......................................................... 43
Applying the Phone Effect ......................................................... 44
Adding Delays ............................................................................. 45
Adding Reverb ............................................................................ 46
Removing Vocals in Music ......................................................... 47
Applying VST Effects ................................................................. 48

Restoring Audio ................................................................. 49
Using Visual Repair ................................................................... 49
Regional Selection Tools ......................................................... 49
Repairing the Audio ............................................................... 60
Using Noise Reduction ............................................................ 62
Clip Restoration ........................................................................ 63
Using Click Removal .............................................................. 63

Mixing Audio ................................................................. 65

Producing the Audio ............................................................ 69
Supported Formats .................................................................... 69
Producing Audio ....................................................................... 69
Producing Video ....................................................................... 70

Sharing Audio on DirectorZone ........................................... 73

AudioDirector Hotkeys ......................................................... 75

Licensing and Copyright Information ....................................... 77

Technical Support ............................................................... 79
Before Contacting Technical Support ........................................ 79
Web Support
Chapter 1:

Introduction

This chapter introduces the CyberLink AudioDirector program and includes an overview of its features. It also outlines the recommended system requirements for running the program.

Note: this document is for reference and informational use only. Its content and the corresponding program are subject to change without notice.

Welcome

Welcome to the CyberLink family of digital software programs. CyberLink AudioDirector lets you record, trim, cut, restore, and enhance digital audio from both imported audio files or the audio track in your videos. You can also apply effects to audio, save audio in different formats, and mix the audio from multiple sources into one file.

Main Features

CyberLink AudioDirector includes many features that make your audio editing easier than before. This section describes the main features in the CyberLink AudioDirector program.

In CyberLink AudioDirector, you can perform the following functions:

- edit audio files or the audio track of an imported video file.
- download sound clips from DirectorZone.
- record custom audio using a microphone or other input device, directly into the audio timeline.
- restore audio by applying the Click Removal, Noise Reduction, or Clip Restoration functions, or use Visual Repair for more precise fixing.
- apply a number of effects to audio files, including delays, reverb, dynamic range compression, vocal removal, and more.
- import and apply custom VST plugin effects to your audio files.
- mix up to 100 audio tracks into one customized audio file.
• share created audio files on DirectorZone.

DirectorZone

DirectorZone is a web service that lets you download sound clips created by other users, so you can use them in your audio. You may also share your own custom sound clips by uploading them to DirectorZone.

To access the benefits of DirectorZone, click the Sign in to DirectorZone link on the top of the CyberLink AudioDirector window.

Go to http://directorzone.cyberlink.com to view more information on the features and benefits of the DirectorZone web site.

Updating AudioDirector

Software upgrades and updates (patches) are periodically available from CyberLink. CyberLink AudioDirector automatically prompts you when either is available.

Note: you must connect to the Internet to use this feature.

To update your software, do this:

1. Open the Upgrade Information window by doing one of the following:
   • click the button.
   • click on the AudioDirector logo in the top right corner, and then on the Upgrade button in the About AudioDirector window.

2. Click the feature you would like to upgrade to, or the patch you want to update CyberLink AudioDirector with.

3. A web browser window opens, where you can purchase product upgrades or download the latest patch update.
# System Requirements

The system requirements listed below are recommended as minimums for running CyberLink AudioDirector.

**Note:** to ensure you can enjoy all the features within CyberLink AudioDirector, make sure your computer meets or exceeds the minimum system requirements.

<table>
<thead>
<tr>
<th>Minimum System Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OS</strong></td>
</tr>
<tr>
<td>• Windows 8/7/Vista/XP (with DirectX 9 or above).</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
</tr>
<tr>
<td>• 512 MB (1 GB recommended).</td>
</tr>
<tr>
<td><strong>CPU</strong></td>
</tr>
<tr>
<td>• Pentium 4 1.8 GHz.</td>
</tr>
<tr>
<td><strong>HDD Space</strong></td>
</tr>
<tr>
<td>• 100 MB free space required for transcoding audio.</td>
</tr>
<tr>
<td><strong>Sound Card</strong></td>
</tr>
<tr>
<td>• Windows-compatible sound card.</td>
</tr>
<tr>
<td><strong>Device</strong></td>
</tr>
<tr>
<td>• Microphone for recording audio.</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
</tr>
<tr>
<td>• 1024x768 16 bit color or higher.</td>
</tr>
</tbody>
</table>
CyberLink AudioDirector
Chapter 2:

AudioDirector Workspace

This chapter provides a complete overview of the CyberLink AudioDirector workspace. It also takes you through the settings used to customize the program to your preference.
CyberLink AudioDirector

View, M - Timeline Zoom Controls, N - Audio Level Meter, O - Keyframe Panel, P - Expand Workspace, Q - Record Audio, R - Playback Controls, S - Adjustments and Effects Panel

AudioDirector Rooms
CyberLink AudioDirector has the following main rooms: the Edit, Restore, and Mix rooms.

- **Edit**: in this room you can adjust, trim, cut, and enhance digital audio, and much more. See Editing Audio for more information.

- **Restore**: in this room you can repair audio clips using the Click Removal, Clip Restoration, and Noise Reduction features, or manually fix audio using the Visual Repair. See Restoring Audio for more information.

- **Mix**: in this room you can record and mix multiple audio tracks into one customized audio file. See Mixing Audio for more information.

The workspace within each CyberLink AudioDirector room is different, but do contain common features and areas. All the rooms have the audio library, as well as the AudioDirector quick bar you use to edit and add audio as required.

Media Library
When you import media into CyberLink AudioDirector, it is available in the media library. You can freely edit, restore, and apply effects to all of the media in the media library, or use the media in the Mix room.

You can import audio and also video files into the media library, as CyberLink AudioDirector lets you edit and restore the audio track of videos you import.

See Importing Media into the Library for more information on importing audio and videos files into the media library.

Adjustments and Effects Panel
The adjustments and effects panel is where you set the edits you want to make to your audio clips and apply effects. The adjustments and effects that are displayed depends on which room you are in.
AudioDirector Timeline

The timeline is a visual representation of digital audio files selected in the media library. When a media file is selected, CyberLink AudioDirector displays each of its audio channels separately in the timeline.

**Note:** the timeline can display up to 8 channels (7.1 channel). See Audio Channels for more information.

By default, the values along the top represent the playback time, while the values along the right indicate the audio intensity, or loudness, measured in decibels.

By default, you can switch the view of the timeline by clicking the buttons in the top right corner of the program. See Timeline View for more information.

The timeline is available in the Edit, Restore, and Mix rooms of CyberLink AudioDirector, and is where you work on editing, restoring, and mixing your audio files.

When you click the play button, the timeline slider begins to move, indicating the current playback position. If required, you can click and drag the timeline slider to any position if you want to jump forward in the audio.

In the Mix room there are multiple tracks in the timeline. Each file you add, adds another layer of audio onto the final outputted media.
See Mixing Audio for information on mixing audio in CyberLink AudioDirector.

Audio Channels

When a media file is selected in the library, CyberLink AudioDirector displays all of its audio channels in the timeline. The timeline can display up to eight channels, and supports the following audio channel configurations:

- 7.1 surround sound (8 channels).
- 5.1 surround sound (6 channels).
- stereo (2 channels).
- mono (1 channel).

Note: CyberLink AudioDirector supports the import and edit of audio and video files with 5.1 channel audio. It also supports the import of audio and video files with 7.1 channels, but only for .WAV audio files are all 8 channels displayed in the program and available for editing. For video files with 7.1 channel audio, two of the audio channels (BL/BR) are hidden and unavailable for editing.

Multi-Channel Display

When a media file has more than one audio channel, each audio channel is labeled in the top left corner. The following table defines the terminology for all the possible audio channel types available in a selected media file and the possible availability for the various audio channel configurations:

<table>
<thead>
<tr>
<th>Channel Label</th>
<th>Channel Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>Front left</td>
</tr>
<tr>
<td>R</td>
<td>Front right</td>
</tr>
<tr>
<td>C</td>
<td>Center</td>
</tr>
<tr>
<td>LFE</td>
<td>Low-frequency effects</td>
</tr>
<tr>
<td>BL</td>
<td>Back left</td>
</tr>
<tr>
<td>BR</td>
<td>Back right</td>
</tr>
<tr>
<td>LC</td>
<td>Front left of center</td>
</tr>
<tr>
<td>RC</td>
<td>Front right of center</td>
</tr>
</tbody>
</table>
Selecting Channels for Editing

When you are editing and restoring audio in CyberLink AudioDirector, you can choose to apply the edits, effects, fixes, etc. to all the channels, or just one single channel.

Click if you want to apply the edits to all of the audio channels, or to make edits on one specific channel only. Once selected, just click the channel you want to apply the edits to in the timeline.

Note: the type of channel that is available in the selected media file is completely dependent on the audio configuration of the file.
Range Selection

When editing and restoring audio, drag the timeline slider to a position in the timeline (or use the playback controls to find the position), and then click and drag one of the blue nodes on either side of the timeline slider to select a range of the audio file.

You can also click and drag on the waveform directly to select a range of the audio.

Note that when you select a range of the audio, the editing tools on the AudioDirector quick bar become active. See Using the Editing Tools for detailed information about using each of these tools.

Details about the selected range are indicated in the Start, End, and Length fields below the timeline. Once you have a range of an audio file's wave form selected, you can then preview, cut, copy, delete or crop it as required.

Timeline View

When a file is selected in the media library in the Edit or Restore rooms, CyberLink AudioDirector by default displays the waveform view for each channel in the timeline.

There are two available timeline views to choose from: click for the waveform view, or for spectral frequency view.

Click the buttons in the top right corner of the timeline to switch between the two available views.
Waveform View

When a file is selected in the media library, CyberLink AudioDirector by default displays the waveform information for each channel in the timeline. The waveform view is a visual representation of both the time and the audio intensity (or loudness, measured in decibels) of the audio in each channel.

Spectral Frequency View

The spectral frequency view is a graphical representation of the audio in each channel, and is ideal when using the Visual Repair feature. The colored graph you see in this view is a three dimensional illustration of the audio attributes in the selected media file.
The graph shows playback time along the top, and the frequency (relative pitch) of the audio (measured in hertz) along the right. The colors on the graph indicate the amplitude or strength of the audio at the point in time. The lighter the color, the louder the audio is at that frequency and time.

**Timeline Markers**

When editing, restoring, or mixing audio, click 📌 to add a timeline marker at the current position of the timeline slider. Markers are used to mark the positions in your audio files where you might want to edit the audio file or start an effect from. In the Mix room, use markers when adding audio clips as they will snap to the timeline markers.

**Adding Timeline Markers**

To add a timeline marker, do this:

1. Use the playback controls to find, or drag the timeline slider to the position where you want the marker, and then click 📌.
2. Input a **Description** for the new timeline marker, if required.
3. Click on **OK** to add the new timeline marker.

*Note: you can double click on a time marker to edit its properties, if required.*

**Timeline Zoom**

When editing, restoring, or mixing audio on the timeline, use the controls to zoom in on the audio timeline to make your editing more precise. There are two types of zooming available: horizontal zoom and vertical zoom.

*Note: when using the zoom controls, you can click the button at any time to zoom all the way back out for a full view of the audio waveform.*

**Horizontal Zoom**

The horizontal zoom controls let you increase/decrease the time magnification of the audio in the timeline.
Use these zoom controls if you want to, for example, zoom in on a specific two seconds in an audio clip.

**Vertical Zoom**

Vertical zoom lets you increase/decrease the intensity magnification of the audio in the timeline.

Use these zoom controls if you want to, for example, zoom in on a specific noise to get a closer look at the waveform.

**AudioDirector Quick Bar**

The AudioDirector quick bar offers you several tools you can access in all the rooms. Depending on which room you are in, the buttons on the quick bar differ.

The available functions on the AudioDirector quick bar are as follows:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Cut" /></td>
<td>In all the rooms you can click on this button to cut a selected portion out of the audio file, and place it on your clipboard for pasting. See <a href="#">Using the Editing Tools</a> for more detailed information.</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>In all the rooms you can click on this button to make a copy of a selected portion on your clipboard for pasting. See <a href="#">Using the Editing Tools</a> for more detailed information.</td>
</tr>
<tr>
<td><img src="image" alt="Paste" /></td>
<td>In all the rooms you can click on this button to paste the audio waveform you cut or copied to the right of the current timeline position. See <a href="#">Using the Editing Tools</a> for more detailed information.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>In all the rooms you can click on this button to delete a selected portion of the audio file. See <a href="#">Using the Editing Tools</a> for more detailed information.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>In all the rooms you can click on this button to crop to the selected portion of the audio file. See <a href="#">Using the Editing Tools</a> for more detailed information.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>![Icon]</td>
<td>In all the rooms you can click this button to add timeline markers at the current timeline slider position. See <a href="#">Timeline Markers</a> for more detailed information.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>In all the rooms you can click this button to share the selected audio file on DirectorZone. See <a href="#">Sharing Audio on DirectorZone</a> for more detailed information.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>In all the rooms you can click this button to produce the selected audio or video file, exporting it with all the edits you made applied. See <a href="#">Producing Audio</a> for more detailed information.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Click this button in the Mix room to configure the profile settings of the mixed audio you produce. See <a href="#">Mixing Audio</a> for more detailed information.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Click this button in the Mix room to add a mix track to the timeline. See <a href="#">Mixing Audio</a> for more detailed information.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Click this button in the Mix room to split an audio file that is selected on a mix track into two separate parts. See <a href="#">Mixing Audio</a> for more detailed information.</td>
</tr>
</tbody>
</table>
# Playback Controls

Once media is imported into the program, use the available playback controls to preview it. To preview a file, select it in the media library and then use the controls as follows:

<table>
<thead>
<tr>
<th><strong>Playback Controls</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="Play" /></td>
<td>Click to play the audio from the current position to the end of the track.</td>
</tr>
<tr>
<td><img src="Image" alt="Pause" /></td>
<td>Click to pause playback.</td>
</tr>
<tr>
<td><img src="Image" alt="Stop" /></td>
<td>Click to stop playback.</td>
</tr>
<tr>
<td><img src="Image" alt="Loop" /></td>
<td>If <img src="Image" alt="Loop" /> is displayed, the current audio file plays to the end of the track. If <img src="Image" alt="Loop" /> is displayed, the audio will loop continuously until you click pause or stop. Click to toggle between the two available audio playback behaviors.</td>
</tr>
<tr>
<td><img src="Image" alt="Jump to Beginning" /></td>
<td>Click to make the timeline slider jump to the beginning of the current selected audio track or selected range of the audio waveform.</td>
</tr>
<tr>
<td><img src="Image" alt="Rewind" /></td>
<td>During playback, click and hold this button to rewind through the current audio track.</td>
</tr>
<tr>
<td><img src="Image" alt="Fast Forward" /></td>
<td>During playback, click and hold this button to fast forward through the current audio track.</td>
</tr>
<tr>
<td><img src="Image" alt="Jump to End" /></td>
<td>Click to make the timeline slider jump to the end of the current selected audio track or selected range of the audio waveform.</td>
</tr>
<tr>
<td><img src="Image" alt="Record" /></td>
<td>Click to record custom audio in CyberLink AudioDirector. See <a href="#">Recording Audio</a> for detailed information on recording custom audio in the program.</td>
</tr>
</tbody>
</table>
Video File Playback

When you import video files into the library, a small video preview displays in the bottom left corner of the CyberLink AudioDirector window when it is selected. When you click play, the video plays with the audio for added reference when editing the video file's audio track.

During playback, you can:

- click 📺 to minimize the video preview window. Click 📺 to restore it.
- click 🎧 to undock the preview window if you would like a larger preview that you can resize to your preference.
the video preview window also includes slightly different playback controls, that include the ‹ and › buttons you can use to step backwards or forwards one frame when the video is paused.

- click ❯❯ to re-dock the preview window to the bottom left.

**Audio Level Meter**

Use the audio level meter to view the audio level, or loudness in decibels, of the current clip at different moments in time during playback. If the audio levels rise to the red levels, you can adjust the master volume to lower the audio level.

In the Mix room, each mix track has its own audio level meter. Just use the volume slider to the left of the track to adjust the audio level as necessary.
Expanding the Workspace

You can adjust the CyberLink AudioDirector workspace to fit your editing requirements. For example, you can expand out the adjustment and effects panel to get better look at all the available controls, if required.

You can also expand the keyframe panel for a better view when adjusting the master volume and panning audio left or right. Doing so, reduces the width of the audio tracks in the timeline.
If you have lots of media in the library, you can expand it to view all the files.
**Keyframes Panel**

The keyframes panel provides powerful and precise editing tools in the Edit room. On the **Volume** tab you can adjust the master volume of audio, or pan audio to the left or right channel. On the **Effect** tab, you can precisely apply multiple effects to a single audio clip.

**Volume Tab**

On the Volume tab on the keyframes panel, you can adjust the master volume and pan audio the left or right.

![Volume Tab Image]

See [Adjusting Master Volume](#) and [Panning Audio Left/Right](#) for more detailed information on the use of these editing features.

**Effect Tab**

The Effect tab shows you precisely where effects you applied are located in the audio clip you are editing.

![Effect Tab Image]

On this tab you can perform the following on the effects:

- deselect an effect to disable it and preview the audio without the effect applied. Reselect it to reapply it.

- hover your mouse over the effect on the tab and then click ![Edit Button] to edit the
effect in the effects panel.

- to remove effects, hover your mouse over the effect on the tab and then click on the individual effect. Click on the right of the panel to remove all the similar effects from the entire timeline.

AudioDirector Preferences

Use the CyberLink AudioDirector preferences to select a UI language, set the default profile settings for audio files, and more.

To configure your preferences in CyberLink AudioDirector, click the button.

General Preferences

In the Preferences window, select the General tab. The available options are as follows:

Internet

- **Automatically check for software updates**: select to periodically check for updates or new versions of AudioDirector automatically.

Language

- **Use system default language**: select this option for the language display to be the same as the language of your operating system.
- **User defined**: select this option and then select the language from the drop-down list that you want to use.

File Preferences

In the Preferences window, select the File tab. The available options are as follows:

**File default profile settings:**

- **Sample rate**: select the sample rate from the drop-down that CyberLink AudioDirector will use by default when producing audio.
- **Bit depth**: select the default bit depth from the drop-down that CyberLink AudioDirector will use when producing audio.
- **Channels**: select the default number of channels you want in the audio files
produced by CyberLink AudioDirector.

**Project Preferences**

In the Preferences window, select the Project tab. The available options are as follows:

**Default project folder:**

- **Project folder**: set the folder where CyberLink AudioDirector project files are saved by default. To change this folder, click ![folder_icon] and then select a new folder.

- **Working folder**: set the folder that CyberLink AudioDirector uses to store the working files it creates when editing, mixing, and adding effects to your audio. To change this folder, click ![folder_icon] and then select a new folder.

**Project default settings:**

- **Sample rate**: select the default sample rate from the drop-down of the audio in newly created projects.

- **Bit depth**: select the default bit depth from the drop-down of the audio in newly created projects.

- **Channels**: select the default number of channels of the audio in newly created projects.

**DirectorZone Preferences**

In the Preferences window, select the DirectorZone tab. The available options are as follows:

**Auto sign in:**

- **Auto sign in to DirectorZone when AudioDirector is launched**: select this option and then enter in your e-mail address and password to automatically sign in to DirectorZone when the program is opened. If you do not have a DirectorZone account, click on the **Get an Account** button.

**Privacy rules:**

- **Allow DirectorZone to gather editing information**: select this option to allow DirectorZone to collect information about how you edited the sound clips.
you are uploading to DirectorZone.

Audio Setting Preferences

In the Preferences window, select the Audio Setting tab. The available options are as follows:

Audio hardware settings

- **Default input**: from the drop-down select the audio hardware device, such as a microphone, that you want to use by default when recording audio in CyberLink AudioDirector.

- **Default output**: from the drop-down select the default output device for audio played back in CyberLink AudioDirector.
CyberLink AudioDirector
Chapter 3:

**Importing Media into the Library**

You can import both audio and video files into CyberLink AudioDirector, from your hard drive or from a removable device. You can also record your own custom audio, or download sound clips from DirectorZone directly into the library.

**Importing Audio and Video Files**

To import audio or video from your hard drive or a removable device, click ![Folder Icon], browse to its location, and then click on **Open**. You can import multiple files into the library at once and then work on them all in CyberLink AudioDirector.

When importing video files you must make sure that **Video files** is selected from the format type drop-down so that the files you are trying to import are visible.

Once imported, use the playback controls to preview both the audio and video. See [Playback Controls](#) for more information.

**Supported Formats**

CyberLink AudioDirector supports the import of audio and video files in the following formats:

**Audio**: MP3, WAV, WMA, M4A.

**Video**: 3GPP2, AVI, DivX (on Windows 7), DV-AVI, DVR-MS, HD MPEG-2, M2T, MKV (H.264), MOD, MOV, MOV (H.264), MP4, MPEG-1, MPEG-2, MPEG-4 AVC (H.264), TOD, VOB, VRO, WMV, WMV-HD.

*Note:* CyberLink AudioDirector supports the import and edit of audio and video files with 5.1 channel audio. It also supports the import of audio and video files with 7.1 channels, but only for .WAV audio files are all 8 channels displayed in the program and available for editing. For video files with 7.1 channel audio, two of the audio channels (BL/BR) are hidden and unavailable for editing.
Downloading Sound Clips

You can download sound clips from DirectorZone. The sound clips are stored in the Downloaded Sound Clips Library of CyberLink AudioDirector.

Downloading Sound Clips from DirectorZone

You can download sound clips from DirectorZone that was shared by other CyberLink AudioDirector users.

To download sound clips from DirectorZone, do this:

1. Click on CyberLink AudioDirector launches DirectorZone in your default web browser.
2. You must first sign in to DirectorZone to download content. If you don't have an account, click the Sign up link at the top of the page to get one for free.
3. Select the AudioDirector tab to display all the available sound clips you can download.
4. Find a sound clip that you want to download, and then click the Download Now button underneath it.
5. Click Download again.
6. Save the sound clip to your computer. Find the location on your computer where you saved it, and then double-click on it to install it in the Downloaded Sound Clips Library.

Downloaded Sound Clips Library

Click the button to open the Downloaded Sound Clips Library of CyberLink AudioDirector. In the Downloaded Sound Clips Library you can manage and organize the clips you downloaded from DirectorZone.

In the Downloaded Sound Clips Library you can:

- view sound clips by style.
- preview the sound clips in the library.
import the selected sound clips into your current project.

Recording Audio

In CyberLink AudioDirector you can record your own custom audio in the WAV format, which is added directly into the timeline. The audio that is recorded is placed onto any existing audio in the timeline.

To record audio, do this:

1. If required, click on to open and configure the recording settings. See Recording Settings for detailed information.

2. To begin recording audio, click .

3. Click again to stop recording and save/import the recorded file into the CyberLink AudioDirector library.

Recording Settings

Set your recording settings as follows:

- **Input source**: select the import source or audio device you want to use to record audio with.

- **Monitor input**: set this option to On if you want to hear the import source during the recording. If set to Off, you cannot hear the input source during recording.

- **Countdown timer**: select this option to enable a countdown before CyberLink AudioDirector begins recording audio. Set the length of the countdown (maximum 30 seconds) in the field provided.

Click OK to save any changes you make to the recording settings.
CyberLink AudioDirector
Chapter 4:
AudioDirector Projects

When editing, restoring, and mixing audio in CyberLink AudioDirector, click the button to save your work as a project in the .ads file format, which is used exclusively by CyberLink AudioDirector.

*Note:* a CyberLink AudioDirector project (.ads) file essentially contains a list of the audio and video files in the library, and that you are editing or mixing. The project file maintains a log of all the edits and effects you want to apply to audio, as well as a list of the audio for mixing and other use preferences (volume levels, timeline markers, etc.). Project files do not include the audio and video clips in them.

Use the options in the **File** menu to save, create new, or open existing projects in CyberLink AudioDirector.

*Note:* when you create a new project, CyberLink AudioDirector resets your library.
CyberLink AudioDirector
Chapter 5:

Editing Audio

Once you import media into the library, you can start editing its audio in the Edit room. In the Edit room you can use the editing tools to crop and trim the audio, or use the adjustment options to change audio length, pitch, apply fades, and much more. You can also apply rich audio effects to audio to enhance it, or to achieve a desired result.

If required, click the Edit button to begin editing, adjusting, and applying effects to audio.

Using the Editing Tools

Use the editing tools on the AudioDirector quick bar to crop, trim, and even adding portions (using the paste function) to your audio.

To edit an audio file, do this:

1. Click the Edit button to open the edit audio room.
2. Select the media file in the library that you want to edit.
3. Decide whether you want to perform the edits on all the available channels, or just one channel. See Selecting Channels for Editing for more information on selecting channels.
4. Use range selection to select the portion of an audio file you want to edit. See Range Selection for more information on selecting a range of an audio file.
5. Use the editing tools to perform edits on your audio files as follows:

<table>
<thead>
<tr>
<th>Editing Tools</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Scissors]</td>
<td>Click to cut the selected portion out of the audio file, and place it on your clipboard for pasting.</td>
</tr>
<tr>
<td>![Document]</td>
<td>Click to make a copy of the selected portion on your clipboard for pasting.</td>
</tr>
<tr>
<td>![Paper]</td>
<td>Click to paste the audio wave form you cut or copied to the right of the timeline slider's current position.</td>
</tr>
</tbody>
</table>
Adjusting Audio

Once you have imported media into the library, you can start using the features in the adjustments and effects panel to modify the audio to fit your requirements. To begin, select the media you want to adjust and then click **Adjust Audio** to display all the available adjustment options.

_Note:_ when you make adjustments to audio, they are not applied to the original file until you produce it in the Produce window. See *Producing the Audio* for more information.

Applying Fades

Use the Fades feature to apply fades to audio. You can make the audio fade in or out in a variety of ways.

To apply a fade to audio, do this:

1. Select the media file in the library that you want to adjust.
2. Click **Fades** under the **Adjust Audio** section.
3. Decide whether you want to apply the fade on all the available channels, or just one channel. See *Selecting Channels for Editing* for more information on selecting channels.
4. To fade the audio in from the beginning of the clip, select the **Fade in** option and then set the following:
   - select from one of the three fade in types: 📦 - a gradual fade in that increases the volume proportionately during the length of the fade; 🔄 - fades audio in dramatically at first, and then tapers off towards the end of the fade; 📦 - exponentially increases the audio as it progresses through the
length of the fade.

- **Initial volume**: set the level of the audio's volume at the beginning of the fade in.

- by default the fade in duration is 10 seconds. To change the duration, click and drag the grey square to the desired time you want the fade to end, i.e the audio to be at full volume.

5. To fade the audio out at the end of the clip, select the **Fade out** option and then set the following:

- select from one of the three fade out types:  - a gradual fade out that decreases the volume proportionately during the length of the fade;  - fades audio out dramatically at first, and then tapers off towards the end of the fade;  - exponentially decreases the audio as it progresses through the length of the fade.

- **End volume**: set the level of the audio's volume at the end of the fade out.

- by default the fade out duration is 10 seconds. To change the duration, click and drag the grey square to the desired time you want the audio to begin fading out.
6. If required, you can preview what the adjusted audio will sound like by selecting **Adjusted result** and then clicking the play button on the playback controls. Select **Original audio** if you want to play the original audio.

7. Click **Apply** to apply the fade.

**Trimming Audio**

Use the Trim Audio feature to trim out unwanted portions from your media clip's audio.

To trim audio, do this:

1. Select the media file in the library that you want to trim.

2. Click **Trim Audio** under the **Adjust Audio** section.

3. Decide whether you want to perform the trim on all the available channels, or just one channel. See **Selecting Channels for Editing** for more information on selecting channels.

4. Use range selection to select the portion of an audio file you want to trim. See **Range Selection** for more information on selecting a range of an audio file.

5. Select the **Mode** of trimming you want to perform as follows:
   - **Remove selected part**: select if you want to trim out the part you selected in
the previous step.

- **Keep selected part**: select if you want to keep the part you selected in the previous step, removing the portions on either side.

  __Note:__ if required, click to use the Mark in and Mark out previews to listen to the audio a few seconds before and after the trim points to ensure you are trimming the audio you want.

6. Click **Apply** to trim the audio.

## Adjusting Length

Use the Adjust Length feature to change the length of audio by speeding it up, or by slowing it down.

To adjust the length of audio, do this:

1. Select the media file in the library that you want to adjust.

2. Click **Adjust Length** under the **Adjust Audio** section.

3. Decide whether you want to perform the adjustment on all the available channels, or just one channel. See Selecting Channels for Editing for more information on selecting channels.

4. If required, use range selection to select the portion of an audio file you want to adjust the length of. If you don't select a range, the adjustment is applied to the entire audio file. See Range Selection for more information on selecting a range of an audio file.

5. To adjust the length of the audio, do one of the following:

   - Manually enter the **New audio length** in the field provided. Use this feature if you want the audio to be an exact specified length.

   - Use the **Stretch ratio** slider if you want to increase/decrease the length by a specific percentage.

     __Note:__ if required, you can use both the **New audio length** and **Stretch ratio** features together to adjust the length of the audio.

6. Select the **Keep pitch** option to have CyberLink AudioDirector maintain the pitch of the original audio, so that the adjusted result does not sound sped up or slowed down.

   __Note: Keep pitch is only available if the change to the audio's length is between 0.5X and 2X.__
CyberLink AudioDirector

7. If required, you can preview the adjusted audio by selecting Adjusted result and then clicking the play button on the playback controls. Select Original audio if you want to play the audio at its original length.

8. Click Apply to adjust the length of the audio.

Adjusting Pitch

Use the Adjust Pitch feature to change the pitch of the audio. The resulting effect is audio that sounds like it is sped up or slowed down, without changing the length of the audio.

To adjust the pitch of audio, do this:

1. Select the media file in the library that you want to adjust.
2. Click Adjust Pitch under the Adjust Audio section.
3. Decide whether you want to perform the adjustment on all the available channels, or just one channel. See Selecting Channels for Editing for more information on selecting channels.
4. If required, use range selection to select the portion of an audio file you want to adjust the pitch in. If you don't select a range, the adjustment is applied to the entire audio file. See Range Selection for more information on selecting a range of an audio file.
5. Drag the Semitones slider to adjust the pitch up or down as required.

**Note:** increasing/decreasing by one semitone is equivalent to changing the overall the pitch up/down one musical note in a 12-tone scale. For example, C to C# (sharp) or C to Cb (flat).

6. If required, you can preview what the adjusted audio will sound like by selecting Adjusted result and then clicking the play button on the playback controls. Select Original audio if you want to play the audio at its original pitch.

7. Click Apply to adjust the pitch of the audio.

Inserting Silence

Use the Insert Silence feature to add a specified amount of silence into audio clips.

To insert silence into audio, do this:
1. Select the media file in the library that you want to add silence to.

2. Click **Insert Silence** under the **Adjust Audio** section.

3. Decide whether you want to perform insert the silence on all the available channels, or just one channel. See [Selecting Channels for Editing](#) for more information on selecting channels.

4. Drag the timeline slider to the position in the audio clip where you want to insert the silence.

5. Enter the duration, in seconds, of the silence to be inserted in the field provided.

6. Click **Apply** to insert the silence.

**Inserting Noise**

Use the Insert Noise feature to add a specified amount of generated noise, or static, into audio clips.

To insert noise into audio, do this:

1. Select the media file in the library that you want to add noise to.

2. Click **Insert Noise** under the **Adjust Audio** section.

3. Decide whether you want to perform insert the noise on all the available channels, or just one channel. See [Selecting Channels for Editing](#) for more information on selecting channels.

4. Drag the timeline slider to the position in the audio clip where you want to insert the noise.

5. Select one of the following types of noise from the **Noise type** drop-down:
   - **Normal**: common white noise, or static, which can be quite loud to the listener.
   - **Pink**: static like noise that sounds softer and quieter than normal white noise.
   - **Brown**: a lower frequency static like noise, which is quite quiet compared to the others.

6. Enter the duration, in seconds, of the noise to be inserted in the field provided.

7. Click **Apply** to insert the noise.
Reversing Audio

Use the Reverse feature to make a selected audio clip play in reverse.

To reverse audio, do this:

1. Select the media file in the library that you want to reverse.
2. Click **Reverse** under the **Adjust Audio** section.
3. Decide whether you want to perform reverse the audio on all the available channels, or just one channel. See **Selecting Channels for Editing** for more information on selecting channels.
4. If required, use range selection to select the portion of an audio file you want to reverse. If you don’t select a range, the adjustment is applied to the entire audio file. See **Range Selection** for more information on selecting a range of an audio file.
5. If required, you can preview what the reversed audio will sound like by selecting **Adjusted result** and then clicking the play button on the playback controls. Select **Original audio** if you want to play the original audio.
6. Click **Apply** to reverse the audio in the selected clip.

Adjusting the Master Volume

CyberLink AudioDirector lets you adjust the volume of an audio file at any point in the timeline. You can make it louder at a certain moment, and then quieter at another, as required.

**Note:** when adjusting the master volume using the volume keys, the adjustments are not applied to the original file until you produce it in the Produce window. See **Producing Audio** for more information.

To adjust the master volume of an audio file, do this:

1. Use the playback controls or drag the timeline slider to the position where you want the audio to reach its loudest/quietest point.
2. Click on the **Volume** tab in the keyframe panel, and then click on the line in the Volume area and drag the volume key to desired volume level.
4. Use the playback controls or drag the timeline slider to locate the position where you want the change in audio level to begin.

5. Click on the line in the master volume area and drag the volume key back to the original volume level.

   Note: this last step is just a recommendation, and is not necessary if you want the audio to fade up or down from the very beginning to the desired level.

6. Continue adjusting the volume keys as required to achieve the desired audio levels throughout the audio file.

7. Preview your edited audio and once you are satisfied with the result, you are ready to save/produce it as a new audio file. See Producing Audio for more information.

**Panning Audio Left/Right**

CyberLink AudioDirector lets you adjust the balance of audio by panning it to the left or right channel, reducing the volume of the audio in the respective channel.

   Note: when panning audio, the adjustments are not applied to the original file until you produce it in the Produce window. See Producing Audio for more information.

To pan the audio, do this:

   Note: when panning 5.1 or 7.1 audio, the center channels are not affected.

1. Use the playback controls or drag the timeline slider to the position where you want to start panning the audio.
2. Click on the **Volume** tab in the keyframe panel, and then click on the line in the L-R pan area and drag the pan key to the desired pan level.

![Pan track audio left or right]

4. Use the playback controls or drag the timeline slider to locate the position where you want the change in pan level to begin.

5. Click on the line in the L-R pan area and drag the pan key back to the original pan level.

![Pan Right:100% Left:100%]

---

**Note**: this last step is just a recommendation, and is not necessary if you want the audio to pan left or right from the very beginning to the desired level.

6. Continue adjusting the pan keys as required to achieve the desired pan levels in each channel throughout the audio file.

7. Preview your edited audio and once you are satisfied with the result, you are ready to save/produce it as a new audio file. See *Producing Audio* for more information.
Applying Audio Effects

In CyberLink AudioDirector you can choose from a number of default effects and apply them to your audio files. You can also import custom VST plugin effects that you downloaded and apply them to your audio.

*Note*: when you apply effects to audio, they are not applied to the original file until you produce it in the Produce window. See Producing the Audio for more information.

Using Dynamic Range Control

Use Dynamic Range Control to adjust the shaping of the dynamics in your audio.

To use dynamic range compression on audio, do this:

1. Select the media file in the library that you want to use dynamic range compression on.

2. If required, use range selection to select the portion of an audio file you want to apply the effect to. See Range Selection for more information on selecting a range of an audio file. If you don't select a range, the effect is applied to the entire audio clip.

3. Decide whether you want to apply the effect on all the available channels, or just one channel. See Selecting Channels for Editing for more information on selecting channels.

4. Click Dynamic Range Control under the Apply Effect section.

5. Use the control sliders as follows:

   * **Limiter**: adjust these sliders to aggressively limit high level signals. You can use the limiter to prevent clipping or distortion.

   * **Compressor**: use these sliders to apply more gentle dynamic control to medium level signals and peaks.

   * **Gate/Expander**: use these sliders to boost (expand) the level of soft signals. Note that the expander can have a ratio greater or less than 1.0. When the ratio is greater than 1, it is operating as a gate and any signals below the threshold will be decreased in volume.

6. Use the Output Gain slider to adjust the output gain for the processed
file to make up for a decrease in the audio's volume.

7. The meter in the top left of the Dynamic Range Control window is a level histogram, or a level meter that keeps track of its history. This allows you to visualize the overall "level content" of the audio by providing a running display of levels over a period of time. By moving the red bar in this display with your mouse, you can adjust the limiter threshold. The center meter is a reduction meter. It shows (in dB) the amount of reduction the compressor/limiter and/or gate is providing. The right meter is a traditional dynamics curve, where the x or horizontal axis is the signal going into the dynamics module, and the y or vertical axis is the signal coming out. As a curve becomes more horizontal, it means the signal is being flattened (compressed) more. You can use your mouse to adjust threshold and ratio controls by clicking on parts of this curve.

8. If required, you can preview how the applied effect will sound by selecting Adjusted result and then clicking the Preview button. Select Original audio if you want to preview the original audio.

9. Click Apply to apply the dynamic range control.

---

Note: if required, click on the Effect tab to see the applied effect in the edit panel. See Effect Tab for more information.

---

**Common Dynamic Range Controls**

When using the Dynamic Range Control sliders, adjusting these common control sliders will have the resulting effects:

- **Threshold**: use to set the point where the dynamics processing takes place.
- **Ratio**: use to set the ratio for its respective dynamics section. Higher ratios will result in more extreme compression, limiting or expansion.
- **Attack**: use to set how quickly the compressor, limiter or expander/gate reacts (in milliseconds) to an incoming signal when the signal passes the specified threshold.
- **Release**: use to set how quickly the module stops applying compression, limiting or expansion/gating when the signal falls below the threshold.

**Using the Equalizer**

Select Equalizer effect to apply preset equalizer filters on your audio. You can also fully customize the overall sound of your audio using the available sliders.
To use the equalizer on audio, do this:

1. Select the media file in the library that you want to use the equalizer on.
2. If required, use range selection to select the portion of an audio file you want to apply the effect to. See Range Selection for more information on selecting a range of an audio file. If you don't select a range, the effect is applied to the entire audio clip.
3. Decide whether you want to apply the effect on all the available channels, or just one channel. See Selecting Channels for Editing for more information on selecting channels.
4. Click Equalizer under the Apply Effect section to open the Equalizer window.
5. If required, select an equalizer preset from the Presets drop down. Equalizer presets can enhance audio, and the preset you should select depends on the type of audio or genre of music you are editing.
6. If required, drag the equalizer sliders to customize the audio effect applied.
7. If required, you can preview how the applied effect will sound by selecting Adjusted result and then clicking the Preview button. Select Original audio if you want to play the original audio.
8. Click Apply to apply the equalizer effect to the audio.

Note: if required, click on the Effect tab to see the applied effect in the edit panel. See Effect Tab for more information.

Applying the Radio Effect

Use the Radio effect to apply a filter to your audio that mimics the sound of a radio.

To apply the radio effect to audio, do this:

1. Select the media file in the library that you want to apply the radio effect to.
2. If required, use range selection to select the portion of an audio file you want to apply the effect to. See Range Selection for more information on selecting a range of an audio file. If you don't select a range, the effect is applied to the entire audio clip.
3. Decide whether you want to apply the effect on all the available channels, or just one channel. See Selecting Channels for Editing for more information on selecting channels.
4. Click **Radio** under the **Apply Effect** section.

5. Select the **Radio type** from the drop down. Each type provides a slightly different effect to your audio.

6. If required, you can preview how the applied effect will sound by selecting **Adjusted result** and then clicking the play button on the playback controls. Select **Original audio** if you want to play the original audio.

7. Click **Apply** to apply the radio effect to the audio.

   _Note_: if required, click on the Effect tab to see the applied effect in the edit panel. See **Effect Tab** for more information.

---

**Applying the Phone Effect**

Use the Phone effect to apply a filter to your audio that mimics the sound over a phone.

To apply the phone effect to audio, do this:

1. Select the media file in the library that you want to apply the phone effect to.

2. If required, use range selection to select the portion of an audio file you want to apply the effect to. See **Range Selection** for more information on selecting a range of an audio file. If you don't select a range, the effect is applied to the entire audio clip.

3. Decide whether you want to apply the effect on all the available channels, or just one channel. See **Selecting Channels for Editing** for more information on selecting channels.

4. Click **Phone** under the **Apply Effect** section.

5. Select the **Phonetype** from the drop down. Each type provides a slightly different effect to your audio.

6. If required, you can preview how the applied effect will sound by selecting **Adjusted result** and then clicking the play button on the playback controls. Select **Original audio** if you want to play the original audio.

7. Click **Apply** to apply the phone effect to the audio.

   _Note_: if required, click on the Effect tab to see the applied effect in the edit panel. See **Effect Tab** for more information.
Adding Delays

Use the Delay effect to add analog and tape-style echoes to your tracks. This vintage gear-inspired delay unit has unique features, including a delay meter that lets you see and adjust the level and spacing of each echo generated.

To add a delay to audio, do this:

1. Select the media file in the library that you want to add the delay to.

2. If required, use range selection to select the portion of an audio file you want to apply the effect to. See Range Selection for more information on selecting a range of an audio file. If you don’t select a range, the effect is applied to the entire audio clip.

3. Decide whether you want to apply the effect on all the available channels, or just one channel. See Selecting Channels for Editing for more information on selecting channels.

4. Click Delay under the Apply Effect section.

5. Select the delay mode you want to use:
   
   - **Tape**: simulates vintage tape echo effects, including saturation and wow/flutter characteristics.
   
   - **Tape/Tube**: another tape delay emulation, featuring additional tube saturation simulating the warmth of old tube-based analog circuitry.
   
   - **Analog**: a lo-fi analog delay effect with smearing and analog degradation, similar to analog guitar stomp boxes.

6. Use the available control sliders to customize the delay as follows:

   - **Dry Out**: sets the output gain of the dry signal without delay added to the signal.
   
   - **Wet Out**: sets the output gain of the wet/delayed signal.
   
   - **Feedback**: sets the gain of the delay feedback. Higher values will result in longer audible feedback times, i.e. more repeats.
   
   - **Trash**: sets the amount of degradation for the delay. For example, higher Trash values for tape delays results in more saturation. Higher Trash values for lo-fi digital delays results in more bit truncation and aliasing.
   
   - **Spread**: for stereo tracks only. Sets the stereo spread of the signal, from mono
(0%) to extra wide (200%).

- **Delay**: sets the delay time in milliseconds by default. If required, select the **Sync To Host** to lock the delay time of the effect to the tempo set in the host program, perfect for creating echoes that are in sync with your project’s rhythm. Use the **Tempo** to set the delay time when selected.

- **Tap**: another method for setting the speed of echoes. Click the **Tap** button in rhythm to sync the delay manually to a tempo.

7. The meter at the bottom of the Delay window shows a series of bars that represent the level of the echoes created by the effect. You can also use this display to control delay parameters as follows:

- drag the first bar up and down to control Dry Out level.
- drag the second bar up and down to control Wet Out level.
- drag the third bar up and down to control Feedback (number of repeats).
- drag the second bar right and left to shorten or lengthen the Delay time.
- click on the meter and move your mouse wheel to adjust the zoom of the display.

8. If required, you can preview how the applied effect will sound by selecting **Adjusted result** and then clicking the **Preview** button on the playback controls. Select **Original audio** if you want to play the original audio.

9. Click **Apply** to add the delay to the audio.

---

**Note**: if required, click on the Effect tab to see the applied effect in the edit panel. See **Effect Tab** for more information.

### Adding Reverb

Use Reverb to apply an effect that reverberates the original audio, i.e. applies an echo-like effect to it.

To add reverb to audio, do this:

1. Select the media file in the library that you want to apply the reverb effect to.

2. If required, use range selection to select the portion of an audio file you want to apply the effect to. See **Range Selection** for more information on selecting a range of an audio file. If you don't select a range, the effect is applied to the entire audio clip.
3. Decide whether you want to apply the effect on all the available channels, or just one channel. See Selecting Channels for Editing for more information on selecting channels.

4. Click Reverb under the Apply Effect section.

5. Use the Sparkle slider to add a grainy sound to the audio. The more sparkle applied, the grainier it will sound.

6. Use the Room width slider to widen a stereo audio signal without disturbing the low frequencies. This allows you to control of the perceived location of the sound, ranging from a more centered source to one that is wider left and right.

7. Use the Room size slider to add reverberation to the audio signal, simulating it being played in a room. Larger values will simulate a larger room.

8. If required, you can preview how the applied effect will sound by selecting Adjusted result and then clicking the play button on the playback controls. Select Original audio if you want to play the original audio.

9. Click Apply to add the reverb effect to the audio.

**Note:** if required, click on the Effect tab to see the applied effect in the edit panel. See Effect Tab for more information.

---

**Removing Vocals in Music**

Use the Vocal Removal in Music effect to create a karaoke mix using your stereo music files. CyberLink AudioDirector creates this effect by panning the vocal track to the center.

**Note:** this effect can only be applied to stereo (two channel) audio files.

To remove vocals in music, do this:

1. Select the music file in the library that you want to remove the vocals from.

2. If required, use range selection to select the portion of an audio file you want to apply the effect to. See Range Selection for more information on selecting a range of an audio file. If you don't select a range, the effect is applied to the entire audio clip.

3. Click Vocal Removal in Music under the Apply Effect section.

4. If required, you can preview how the applied effect will sound by selecting Adjusted result and then clicking the play button on the
playback controls. Select **Original audio** if you want to play the original audio.

5. Click **Apply** to remove the vocals from the audio.

**Note:** if required, click on the Effect tab to see the applied effect in the edit panel. See **Effect Tab** for more information.

## Applying VST Effects

VST plug-in effects are the industry standard for audio processing software. You can purchase, download and then import VST effects into CyberLink AudioDirector for use.

**Note:** check the associated documentation for each VST plugin effect for detailed information on using these effects.

## Importing VST Effects

With VST plug-in effects you can find and add the desired custom effect you want on your audio. VST plug-in effects are widely available for download from the Internet, and can easily be imported into CyberLink AudioDirector.

**Note:** CyberLink does not guarantee the usability of downloaded VST plug-in effects, nor the quality of the VST modules.

If you have downloaded a VST plug-in effect, do this to import it into CyberLink AudioDirector:

1. From the menu select **File > Import VST Plug-in Effects**.

2. Browse to the location where the downloaded VST plugin effect is located.

**Note:** CyberLink AudioDirector imports VST plug-in effects that are in the DLL format. If the downloaded effect is in the ZIP format, you must first unzip it before trying to import it into the program.

3. Select the VST plugin effect and then click **Open** to import the effect into the VST section of CyberLink AudioDirector.

**Note:** Once imported, VST effects are always available in the program every time it is launched. Right-click on imported VST effects and then select **Remove** to remove them from the CyberLink AudioDirector.
Chapter 6:

Restoring Audio

Click on the **Restore** button to repair audio clips using the Click Removal, Clip Restoration, and Noise Reduction features. You can also do more precise and powerful fixing using Visual Repair.

**Note:** when you are repairing audio, the fixes are not applied to the original file until you produce it in the Produce window. See *Producing the Audio* for more information.

Using Visual Repair

If any of your audio clips have unwanted background sounds, such as sirens, car alarms, etc., you can use the visual repair feature to remove them. CyberLink AudioDirector provides several selection tools for you to manually find and select the unwanted sound using the spectral frequency view. The visual repair feature also has three different ways to repair audio - auto attenuate, manual attenuate, and volume adjustment to remove specific unwanted sound.

To access Visual Repair, click the **Visual Repair option** under the **Adjustment** section.

Regional Selection Tools

CyberLink AudioDirector supplies you with five different selection tools that help you to choose the regions of an audio clip you want to repair. Once selected, use the visual repair tools to fix the audio.

**Note:** these regional selection tools are only available when in the spectral frequency view. See *Spectral Frequency View* for more information on selecting this view.
Time Selection

The time selection tool lets you select a vertical area of the audio clip based on playback time. This selection tool is similar to the range selection.

To use the time selection tool, do this:

1. In the Visual Repair section, click on the button.
2. Click and drag on the region of the audio clip you want to repair.

CyberLink AudioDirector vertically selects the all of the content in the region for fixing.
3. Click the button to preview only the selected content to ensure it is what you need to fix.

4. Use the visual repair functions to repair the audio as required. See Repairing the Audio for more information.
Time Frequency Selection

Use the time frequency selection tool to choose a more precise area of the audio, by selecting a rectangular region for fixing.

To use the time frequency selection tool, do this:

1. In the Visual Repair section, click on the button.
2. Click and drag on the region of the audio clip you want to repair.

CyberLink AudioDirector highlights the content in a rectangle for fixing.
3. Click the play button to preview only the selected content to ensure it is what you need to fix.

4. Use the visual repair functions to repair the audio as required. See Repairing the Audio for more information.
Frequency Selection

The frequency selection tool lets you select a horizontal area of the audio clip based on its frequency.

To use the frequency selection tool, do this:

1. In the Visual Repair section, click on the button.
2. Click and drag on the region of the audio clip you want to repair.

CyberLink AudioDirector horizontally selects the all of the content in the region for fixing.
3. Click the button to preview only the selected content to ensure it is what you need to fix.

4. Use the visual repair functions to repair the audio as required. See Repairing the Audio for more information.
Magic Wand Selection

The magic wand selection tool helps you to auto select similar attributes (frequency or amplitude) in the audio clip that may be the area that requires fixing.

To use the magic wand selection tool, do this:

1. In the Visual Repair section, click on the button.
2. Click on the regions of the audio clip you want to repair.

CyberLink AudioDirector auto selects the similar attributes (frequency or amplitude) for fixing.
3. If required, you can select the **Harmonic finder** option to have CyberLink AudioDirector auto select the attributes that have similar harmonic qualities.
4. Click the button to preview only the selected content to ensure it is what you need to fix.

5. Use the visual repair functions to repair the audio as required. See Repairing the Audio for more information.
Brush Selection

You can use the brush selection tool to select, or brush, just the parts of the audio clip you want to repair.

To use the brush selection tool, do this:

1. In the Visual Repair section, click on the brush button.
2. Use the Size slider to set the width of the area selected by the brush.
3. Click, hold down the mouse button, and then drag the mouse over the all regions of the audio clip you want to repair.

Let go of the mouse button to finalize the selected area.
4. Use the visual repair functions to repair the audio as required. See Repairing the Audio for more information.

**Repairing the Audio**

Once you have selected the portion of the audio that you want to repair, use one of the following functions to fix it as required.

**Auto Attenuate**

The auto attenuate function automatically levels off the selected audio so that it has the same attributes as the surrounding audio.

To apply auto attenuate, do this:

1. Select the **Auto attenuate** function.

2. If required, you can preview the repaired audio by selecting **Restored result** and then clicking the play button. Select **Original audio** if you want
to play the original audio.

3. Click **Apply** to repair the selected audio.

### Manual Attenuate

The manual attenuate function lets you manually level off the selected audio so that it has the same attributes as the surrounding audio.

To apply manual attenuate, do this:

1. Select the **Manual attenuate** function.
2. Use the **Strength** slider to set the amount of attenuation you want to apply on the selected area.
3. In the **Direction** drop-down, select whether you want to level off (attenuate) the selected area to match the attributes horizontally (above and below) or vertically (left and right) around it.
4. If required, you can preview the repaired audio by selecting **Restored result** and then clicking the play button. Select **Original audio** if you want to play the original audio.
5. Click **Apply** to repair the selected audio.

### Volume Adjustment

Use this function to manually repair the selected audio by adjusting the volume, or amplitude.

To repair with volume adjustment, do this:

1. Select the **Volume adjustment** function.
2. Use the **Volume** slider to adjust the volume of the selected area.
3. If required, you can preview the repaired audio by selecting **Restored result** and then clicking the play button. Select **Original audio** if you want to play the original audio.
4. Click **Apply** to repair the selected audio.
Using Noise Reduction

Use the Noise Reduction feature if your audio clips contain unwanted static, or other background noise.

To use the Noise Reduction on audio, do this:

1. Select the media file in the library that you want to repair.

2. Decide whether you want to repair all the available channels, or just one channel. See Selecting Channels for Editing for more information on selecting channels.

3. Click Noise Reduction to open the Noise Reduction window.

4. In step 1, select a range of the audio that only contains the noise you want to remove, i.e. devoid of the audio you want to keep in the file. See Range Selection for more information on selecting a range of an audio file.

5. Next, click the Analyze button to analyze the range of audio. Doing this creates a noise profile that CyberLink AudioDirector uses to reduce the audio noise. If required, click the Preview Noise button to listen to the noise.

6. Click the Next button to go to step 2.

7. Select which range of audio you want to apply the noise reduction to by selecting one of the following:

   - **Analyzed range only**: select this option to only apply the noise reduction to the range of audio you selected and analyzed in step 1.

   - **Entire audio content**: select this option if you want to apply the noise reduction to the entire audio clip.

   - **Select a different range**: select this option to select a new range of audio where you want the noise reduction applied. This range can contain both the noise and the audio content you want to keep.

8. Use the Sensitivity and Noise reduction level sliders to adjust the amount of reduction applied to the selected range. If required, click the Preview Noise button again to listen to the noise that will be removed.
**Note:** when previewing the noise, if you hear portions of the audio you want to keep, it is recommended that you reduce the Sensitivity and/or the Noise reduction level until you don't hear it anymore, for the best results on the repaired audio.

9. If required, you can preview the repaired audio by selecting Restored result and then clicking the Preview button. Select Original audio if you want to play the original audio.

10. Click Apply to repair the audio.

## Clip Restoration

Use Clip Restoration feature if parts of your audio’s waveform is clipped off at the top or bottom, causing distortions or loss in audio quality. This feature can restore the waveform through attenuation, resulting in audio that is less intense, but without distorted or lost audio parts.

To use the Clip Restoration on audio, do this:

1. Select the media file in the library that you want to repair.

2. If required, use range selection to select the portion of an audio file you want to repair. See Range Selection for more information on selecting a range of an audio file. If you don't select a range, the entire audio clip is repaired.

3. Decide whether you want to repair all the available channels, or just one channel. See Selecting Channels for Editing for more information on selecting channels.

4. Click Clip Restoration to display the available Clip Restoration controls.

5. Select the Quality amount of the clip restoration. The higher the quality selected, the more attenuation that is applied to the audio, and the lower its resulting intensity or loudness.

6. If required, you can preview the repaired audio by selecting Restored result and then clicking the play button. Select Original audio if you want to play the original audio.

7. Click Apply to repair the audio.

## Using Click Removal

Use the Click Removal feature if your audio clips contain unwanted clicking or related sounds in them.
To use the Click Removal on audio, do this:

1. Select the media file in the library that you want to repair.

2. If required, use range selection to select the portion of an audio file you want to repair. See *Range Selection* for more information on selecting a range of an audio file. If you don't select a range, the entire audio clip is repaired.

3. Decide whether you want to repair all the available channels, or just one channel. See *Selecting Channels for Editing* for more information on selecting channels.

4. Click **Click Removal** to display the available controls.

5. If required, select a preset from the **Presets** drop down. These presets can auto repair your audio for you.

6. Use the **Sensitivity** slider to adjust the amount of Click Removal applied to the selected audio clip.

7. If required, you can preview the repaired audio by selecting **Restored result** and then clicking the play button. Select **Original audio** if you want to play the original audio.

8. Click **Apply** to repair the audio.
Chapter 7:

Mixing Audio

CyberLink AudioDirector lets you mix multiple audio files into one customize audio file. Click the Mix button to open the mix audio room.

To mix audio files, do this:

Note: you can drag a video file onto a track in the Mix room, creating a video track with a corresponding audio track. You can only have one video track in the timeline however, i.e. you can only have one video file with audio in the production you're creating in the Mix room.

1. Drag all the audio files that you want to use in the mix from the library to the tracks on the timeline.

Note: you can add up to 100 audio tracks in the mix timeline. To add a new track, click the button.

2. If required, use the buttons to cut, copy, paste, or delete the audio on the tracks. You can also select an audio file on a track and click to split it into two separate parts that can be moved separately among tracks.

Note: if required, you can click an audio clip on the timeline and drag the beginning or end to quickly trim the audio file length.

3. If required, select an audio clip on a track and click to edit in the Edit room (or right click on it and then select Edit Clip in Edit Room). See Editing Audio for detailed information on editing audio clips.

4. If required, right click on an audio clip on a track and then select Edit Clip in Restore Room to fix in the Restore. See Restoring Audio for detailed information on editing audio clips.

5. Position each audio file to start precisely when you want it by dragging it to the desired starting position.
Note: if you add or move an audio clip onto an existing clip on the timeline, you are asked if you want to split the clip and Insert the new clip between the two portions, or Overwrite the existing clip.

6. Select a track and then use the mixing tools to the left of the track to perform any of the following:

<table>
<thead>
<tr>
<th>Mixing Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
</tr>
<tr>
<td><img src="image6" alt="Icon" /></td>
</tr>
<tr>
<td><img src="image7" alt="Icon" /></td>
</tr>
</tbody>
</table>

6. If required, select an audio clip on a track and go to the Adjustment panel to apply an effect. See Applying Audio Effects for more information.

Note: once an effect is applied to an audio clip, click on to view the Effect List for the click. In the Effect List you can deselect or click to remove the effect from the clip.
7. Preview your audio mix and once you are satisfied with the result, you are ready to mix it down and produce it as a new audio file. See Producing Audio for more information.

Note: before producing the audio file, you can click the button to configure its profile settings. See File Preferences for a description of each of the available profile settings.
CyberLink AudioDirector
Chapter 8:

Producing the Audio

The last step when editing, restoring, and mixing audio files is to save or produce it to a new file. CyberLink AudioDirector uses the original media and then applies all the specified changes to it, creating a new file, either in the same format, or in a new file format if you prefer.

*Note:* if you have CyberLink PowerDirector 11 installed on your computer, you can also select an edited file in the library and then **File > Export Audio to PowerDirector** from the menu to quickly produce and export just the audio to PowerDirector.

**Supported Formats**

CyberLink AudioDirector supports the production of audio files into the following formats:

**Audio:** MP3, WAV, WMA, M4A

**Video:** H.264, MPEG-2, MPEG-4, WMV.

**Producing Audio**

When you are finished performing edits, adding effects, or restoring an audio file in the library, you can save the changes and produce it as a new file. This produce feature is also used when mixing down all the tracks in the Mix room, combining them into a single audio file.

*Note:* you can also convert audio files in the library into other formats using this feature.

To produce your audio file as a new file, do this:

1. Select the audio file in the library you want to save/produce, and then click **Produce** in the AudioDirector quick bar above the timeline. The Produce Audio window opens.

   *Note:* if there is a video file in the Mix room, or it is an edited video file’s audio that you want to produce only, select **Produce Audio** after clicking the **Produce** button.

2. Set the **File information** as follows:
• **Filename**: enter in a new file name for the file.

• **Location**: click on [ ] to set the location of the folder where the produced audio is saved.

• **Format**: select the format you want for the newly produced audio file from the drop-down. See [Supported Formats](#) for information on the supported audio file formats.

3. Use the **Audio profile settings** to set the quality of the produce file as follows:

• **Bitrate**: if required, set the bitrate for the produced file by selecting it from the drop-down.

• **Sample rate**: set the sample rate of the produced file by selecting it from the drop-down.

• **Bit depth**: set the bit depth of the produce file by selecting it from the drop-down.

• **Channels**: set the number of channels the produced file will have. If you are producing it as a WAV file, you can produce it with 5.1 or 7.1 channels, if required.

4. Click on **Produce**. The file is saved to the folder location specified.

   *Note: the new file is also added to the library and is available for use in other projects in CyberLink AudioDirector.*

### Producing Video

After you have edited the audio tracks of an imported video file, use the produce video function to re-render the video with the updated audio applied. This produce feature is also used when mixing down all the tracks in the Mix room, including a video track, and then combining them into a single video file with the mixed audio.

To produce a video file, do this:

1. Select the video file in the library you want to produce, click **Produce** in the AudioDirector quick bar above the timeline, and then select **Produce Video**. The Produce Video window opens.

2. Set the **File information** as follows:

   • **Filename**: enter in a new file name for the file.
• **Location**: click on to set the location of the folder where the produced video is saved.

3. Use the **Video profile settings** to set the quality of the produce file as follows:
   
   • **Video format**: select the format you want for the newly produced video file from the drop-down. See [Supported Formats](#) for information on the supported video file formats.
   
   • **Video profile**: select the video profile, or video quality, of the produced file from the drop-down.

4. Use the **Audio profile settings** to set the quality of the produce file as follows:
   
   • **Audio codec**: select the audio used on the audio portion of the file from the drop-down.
   
   • **Bitrate**: if required, set the bitrate for the video's audio by selecting it from the drop-down.
   
   • **Sample rate**: set the sample rate of the video's audio by selecting it from the drop-down.
   
   • **Bit depth**: set the bit depth of the video's audio by selecting it from the drop-down.
   
   • **Channels**: set the number of channels the video's audio will have. Depending on the video file format and audio codec specified, you can produce it with up to 5.1 channels, if required.

5. Click on **Produce**. The file is saved to the folder location specified.

*Note*: the new file is also saved and available in the audio library of CyberLink AudioDirector.
CyberLink AudioDirector
Chapter 9:

Sharing Audio on DirectorZone

You can share the sound clips you create with other users by uploading them to DirectorZone. The sound clips are first converted to 44100Hz, 16bit .MP3 stereo audio files before they are uploaded. Once shared, other users can download and use them in their own audio creations.

*Note:* the maximum length allowed of sound clips shared on DirectorZone is 30 seconds.

To share a sound clip, select it in the library and then click and then click **Upload** in the CyberLink AudioDirector quick bar above the timeline. Follow the detailed steps in the Upload to DirectorZone wizard to share your audio.
CyberLink AudioDirector
Chapter 10:

AudioDirector Hotkeys

The following is a list of the hotkeys available in CyberLink AudioDirector for your convenience:

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+N</td>
<td>New project</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Open project</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save project</td>
</tr>
<tr>
<td>Ctrl+Shift+S</td>
<td>Save project as</td>
</tr>
<tr>
<td>Ctrl+Q</td>
<td>Import media</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Paste</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>Cut</td>
</tr>
<tr>
<td>Ctrl+Y</td>
<td>Redo</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete</td>
</tr>
<tr>
<td>Alt+C</td>
<td>Open AudioDirector preferences</td>
</tr>
<tr>
<td>F1</td>
<td>Open help</td>
</tr>
<tr>
<td>Esc</td>
<td>Exit countdown timer</td>
</tr>
<tr>
<td>Alt+F4</td>
<td>Close AudioDirector</td>
</tr>
</tbody>
</table>
CyberLink AudioDirector
Chapter 11:

Licensing and Copyright Information

This section contains the AudioDirector licensing and copyright information.

iZotope Software

Intellectual Property Notices and Legends:

iZotope Noise Reduction, iZotope Delay, and iZotope Dynamics, iZotope®; © 2011 iZotope, Inc. All Rights Reserved.
CyberLink AudioDirector
Chapter 12:

Technical Support

This chapter contains technical support information. It includes all the information to find the answers you need to assist you. You may also find answers quickly by contacting your local distributor/dealer.

Before Contacting Technical Support

Please take advantage of one of CyberLink’s free technical support options:

- consult the user’s guide or the online help installed with your program.
- refer to the Knowledge Base in the Support section of the CyberLink web site.

http://www.cyberlink.com/prog/support/cs/index.do

The FAQs may have information and helpful hints that are more current than the User Guide and online help.

When contacting technical support by email or phone, please have the following information ready:

- registered **serial number** (Your serial number can be found on the CD cover, the box cover, or in the e-mail received after you purchased CyberLink products on the CyberLink store).

- the product name, version and build number, which generally can be found by clicking on the product name image on the user interface.

- the version of Windows installed on your system.

- hardware devices on your system (capture card, sound card, VGA card) and their specifications.

- the wording of any warning messages that were displayed (You may want to write this down or take a screen capture).

- a detailed description of the problem and under what circumstances it occurred.
Web Support

Solutions to your problems are available 24 hours a day at no cost on the CyberLink web sites:

**Note**: you must first register as a member before using CyberLink web support.

CyberLink provides a wide range of web support options, including FAQs, in the following languages:

<table>
<thead>
<tr>
<th>Language</th>
<th>Web Support URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td><a href="http://www.cyberlink.com/prog/support/cs/index.do">http://www.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
<tr>
<td>Traditional Chinese</td>
<td><a href="http://tw.cyberlink.com/prog/support/cs/index.do">http://tw.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
<tr>
<td>Japanese</td>
<td><a href="http://support.jp.cyberlink.com">http://support.jp.cyberlink.com</a></td>
</tr>
<tr>
<td>Italian</td>
<td><a href="http://it.cyberlink.com/prog/support/cs/index.do">http://it.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
<tr>
<td>German</td>
<td><a href="http://de.cyberlink.com/prog/support/cs/index.do">http://de.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
<tr>
<td>Spanish</td>
<td><a href="http://es.cyberlink.com/prog/support/cs/index.do">http://es.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
<tr>
<td>Simplified Chinese</td>
<td><a href="http://cn.cyberlink.com/prog/support/cs/index.do">http://cn.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
</tbody>
</table>

**Note**: CyberLink’s user community forum is only available in English and German.
Index

5
5.1 8, 25

7
7.1 8, 25

A

Attenuate 60
Audio
  adding markers 12
  attenuate 60
  converting 69
  downloading 26
  editing 31
  effects 41
  exporting 69
  fading 32
  importing 25
  inserting noise 37
  inserting silence 36
  length 35
  level meter 17
  mixing 65
  mixing down 69
  noise reduction 62
  panning 39
  pitch 36
  playback controls 15
  producing 69
  recording 27
  removing clicks 63
  removing vocals 47
  repairing 49
  restoring 49
  reversing 38
  saving 69
  sharing 73
  speed 35
  supported formats, export 69
  supported formats, import 25
  trimming 34

C

Change speed 35
Channels 8, 25
  editing 9
Clicks
  removing 63
Clip restoration 63
Controls
  zoom 12
Convert 69
Create
discs 6
Crop
  range 10
Delays 45
DirectorZone 22, 26, 73
  overview 2
Dynamic range control 41
Echo 46
Edit
  audio 6, 31
  tools 31
Effects 20
  applying 41
  importing 48
  VST 48
Equalizer 42
Export 69
Fades 32
Hotkeys 75
Import 25
  effects 48
Language
  changing 21
Levels 17
Library 6
Markers
  timeline 12
Master volume 38
Media
  editing 31
  importing 25
  playback controls 15
Meter 17
Mix 65
  audio 6
  timeline 7
Mix down 69
Mono 8
New features 1
Noise
  inserting 37
  reducing 62
O
Overwrite 65

P
Pan 39
Phone 44
Pitch 36
Playback 15
Plug-ins 48
PowerDirector 69
Preferences 21
Produce 69
  audio 69
  video 70
Projects 29

Q
Quick bar 13

R
Radio 43
Range selection 10
Record 27
Restoration 63
Reverb 46
Reverse 38

S
Save
  projects 29
Share 73
Silence 36
Slider 7
Sound clips library 26
Spectral frequency view 11
Speed 35
Split 65
Stereo 8
Support 79
System requirements 3

T
Technical support 79
Timeline
  markers 12
  mix audio 7
  overview 7
  slider 7
Trim 34
  range 10

U
UI language 21
CyberLink AudioDirector

V

Videos
  editing audio 31
  importing 25
  playback controls 16
  producing 70
Views
  spectral frequency 11
  waveform 11
Visual repair 49
Vocals 47
Volume 20, 38
VST effects 48

W

Waveform view 11
Web support 80

Z

Zoom 12